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This guide describes the steps for preparing for and performing an LC-MS/MS system integration test for a NanoLC
System combined with the SCIEX TripleTOF

®
4600, 5600/5600+, or 6600/6600+ mass spectrometer. The system

might include the cHiPLC
®
 System or an external column and one of the following NanoLC Systems:

• NanoLCTM 400 System

• NanoLC Ultra
®
 System

• NanoLCTM System

• TempoTM System

Note: Read the safety instructions in the Operator Guide prior to running the system integration test.

Note: For information about assembly and operation of the NanoSpray
®
 or OptiFlowTM Turbo V Ion Source, refer

to the  Ion Source Operator Guide. For information about assembly and operation of the Digital PicoView
®

Nanospray Ion Source, refer to the Digital PicoView Nanospray Source Hardware Manual.

Note: Optimize the ion source before beginning this test.

About the Test
The test in this document determines the performance level of the LC-MS system. This test can be used as a
measure of the system performance. The results from this test can provide a baseline measurement of system
performance. The test can be performed regularly and used as a system quality control test in the future. Record
the test results in the System Integration Test Data Log and Signoff.

Perform this test when the mass spectrometer is known to be operating well and meeting performance specifications.
Refer to Mass Spectrometer System Calibration and the Ion Source Tests, Specifications, and Data Log
document.

If the LC system has been idle for two weeks or more, re-initialize transducers, then verify the flow rate and, if
necessary, calibrate.

Before starting the test, make sure that the system is plumbed in a trap-and-elute configuration (with either the
cHiPLC

®
 System or an external trap and column). Refer to Plumbing Diagrams.
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Note: The test in this document is written with Gradient 1 as the low-flow channel. If this is not true for the
system being tested (for example, a 2D system), then make the appropriate changes throughout the test. Refer
to Table 1-1.

Table 1-1 Channel Flow Rate

Flow RateChannelPump

300 nL/minLow flowGradient 1

5 µL/minHigh flowLoading pump

Time Required
Approximate time required:

1. Create the methods and batch: 45 minutes

2. Prepare the system for testing: 60 minutes (or 3 to 4 hours if the column needs conditioning)

3. Perform the test: 3 hours

Required Materials

Note: If you are not using pre-mixed solvents, make sure that you use LC-MS-grade water, acetonitrile, and
formic acid.

Note: We do not recommend using Milli-Q water because it is not of suitable quality for use in LC-MS systems.

Table 1-2 Required Materials for All Configurations

Part NumberVendor

4465867SCIEXLC-MS Peptide Calibration kit

4465938SCIEXBeta-galactosidase digest

BJLC441-1.0VWRBurdick and Jackson acetonitrile with 0.1% formic acid (or equivalent)

BJLC452-1VWRBurdick and Jackson water with 0.1% formic acid (or equivalent)
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Table 1-3 Required Materials for a NanoLC System with a cHiPLC
®
 System

Part NumberDescription

804-00001Reversed phase cHiPLC
®
 column (75 µm × 15 cm ChromXPTM C18-CL 3 µm 120 Å)

804-00006cHiPLC
®
 trap (200 µm × 0.5 mm ChromXPTM C18-CL 3 µm 120 Å)

800-00389Trap-and-elute jumper chip

Table 1-4 Required Materials for a NanoLC System with an External Column

Part NumberDescriptionIon Source

805-00120Reversed phase ChromXPTM nanoLC column (75 µm ID × 15 cm,
ChromXPTM C18 3 µm 120 Å)

NanoSpray
®
 or Digital

PicoView
®
 Nanospray Ion

Source
5016752ChromXPTM nanoLC Trap column (350 µm ID × 0.5 mm,

ChromXPTM C18 3 µm 120 Å)

910-00051NanoSpray emitter tip

SCIEX 5073903bioZen Peptide Polar-C18 column (75 µm ID × 15 cm, Polar-C18
3 µm 100 Å)1

OptiFlowTM Turbo V Ion
Source

Phenomenex
00F-4782-AW-SX

SCIEX 5073904

Phenomenex
05N-4252-AW

Nano Trap RP-1 trap column (75 µm ID × 1.0 cm, RP-1)1

5068771SteadySpray NANO probe with a NANO electrode

1 This column only available for purchase by users from Phenomenex. The equivalent SCIEX part is only available
to Field Service Employees (FSEs).
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Create the Methods
Create the autosampler and LC methods in the Eksigent Control  Software and the acquisition method in the
Analyst

®
 TF Software.

Create the Autosampler Method

1. Plumb the autosampler valve with a 10 µL sample loop.

2. Open the Analyst
®
 TF Software.

3. In the Autosampler control window, click Method Editor.

4. Create the autosampler method for a trap-elute configuration. Refer to the appropriate appendix for the system.

• Methods for NanoLCTM 400 Systems with a cHiPLC
®
 System

• Methods for NanoLCTM 400 Systems with an External Trap and Column

• Methods for NanoLC Ultra
®
 Systems with a cHiPLC

®
 System

• Methods for NanoLC Ultra
®
 Systems with an External Trap and Column

• Methods for NanoLCTM and TempoTM Systems with a cHiPLC
®
 System

• Methods for NanoLCTM and TempoTM Systems with an External Trap and Column

5. Type the name of the method as specified in the appendix, and then click Save.

6. Click OK.

Create the LC Methods
Fill the aqueous channel for each pump (side A) with buffer A. Fill the organic channel (side B) with buffer B. For
the loading pump, buffer A is always used. Required buffers are shown in Table 2-1.
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Table 2-1 Mobile Phase Mixtures

ModifierBuffer BBuffer A

0.1% formic acid100% acetonitrile100% waterGradient 1

0.1% formic acid100% acetonitrile100% waterGradient 2

0.1% formic acidN/A100% waterLoading pump

Create the Loading Pump Method

In this method, the loading pump is the channel with the microflow module.

1. Open the Analyst
®
 TF Software.

2. In the Acquisition window that opens (from the Eksigent Control  Software), click the arrow in the top, right
corner of the window to select the high-flow or loading pump.

3. Click LC Methods.

4. Create the loading pump method. Refer to the appropriate appendix for the system:

• Methods for NanoLCTM 400 Systems with a cHiPLC
®
 System

• Methods for NanoLCTM 400 Systems with an External Trap and Column

• Methods for NanoLC Ultra
®
 Systems with a cHiPLC

®
 System

• Methods for NanoLC Ultra
®
 Systems with an External Trap and Column

• Methods for NanoLCTM and TempoTM Systems with a cHiPLC
®
 System

• Methods for NanoLCTM and TempoTM Systems with an External Trap and Column

5. Type the method name as specified in the appropriate appendix.

6. Click Save.

7. Click OK.

Create the Gradient Method

For the analytical gradient (typically on the gradient 1 channel with the nanoflow module), create the gradient
method.

1. In the Acquisition window that opens (from the Eksigent Control  Software), click the arrow in the top, right
corner of the window to select the nanoflow or gradient pump.

2. Click LC Methods.

3. Create the gradient method. Refer to the appropriate appendix for the system:

NanoLCTM SystemsSystem Integration Test and Data Log
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• Methods for NanoLCTM 400 Systems with a cHiPLC
®
 System

• Methods for NanoLCTM 400 Systems with an External Trap and Column

• Methods for NanoLC Ultra
®
 Systems with a cHiPLC

®
 System

• Methods for NanoLC Ultra
®
 Systems with an External Trap and Column

• Methods for NanoLCTM and TempoTM Systems with a cHiPLC
®
 System

• Methods for NanoLCTM and TempoTM Systems with an External Trap and Column

4. Type the method name as specified in the appropriate appendix.

5. Click Save.

6. Click OK.

Create the Acquisition Method

1. Close the Eksigent Control  Software, if it is open.

2. Verify that the Analyst
®
 TF Software drivers are installed. Refer to the appropriate installation document for

details.

3. Open the Analyst
®
 TF Software.

4. Create a hardware profile.

5. On the Navigation toolbar, click Acquire > Method Wizard.

Figure 2-1 Method Wizard Window - Choose Methods Tab

6. In the Choose MS Method list, select ToF MS + Hi Resolution Product Ion (+).

System Integration Test and Data LogNanoLCTM Systems
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7. Specify the LC method in one of the following ways:

• If an autosampler and LC method have already been associated with an acquisition method, in the Choose
LC Method list, select the existing acquisition method (.dam).

• If an autosampler and LC method has not been used before, then select No LC Method.

Tip! Any method can be selected as it can be edited after creation of this acquisition method.

8. In the Save Method As field, type System Integration Test for the acquisition method, and then press
Enter.

9. Click Next.

10. On the Ion Source Parameters tab, specify the source conditions that were determined during the ion
source test.

• For the NanoSpray
®
 or OptiFlowTM Turbo V Ion Source, refer to the Ion Source Tests, Specifications,

and Data Log.

• For the Digital PicoView
®
 Nanospray Ion Source, refer to the  NanoLC Systems Installation Checklist

and Data Log.

Figure 2-2 Method Wizard - Ion Source Parameters Tab

11. Click Next.

12. On the TOF MS - MS/MS tab, specify the acquisition parameters.

NanoLCTM SystemsSystem Integration Test and Data Log
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Note: The acquisition time should be more than 1 minute shorter than the LC run time.

Table 2-2 Acquisition Parameters

ValueParameter

400Start TOF Mass (Da)

1800Stop TOF Mass (Da)

0.250TOF Accumulation Time (s)

100MS2 Start Mass (Da)

1800MS2 Stop Mass (Da)

0.5MS2 Accumulation Time (s)

42Mass Spec Acquisition Duration (min)

729.3652Product of m/z (Da)

45Collision Energy (V)

3Collision Energy Spread (V)

System Integration Test and Data LogNanoLCTM Systems
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Figure 2-3 Method Wizard - TOF MS - MS/MS Tab

13. Click Finish.

Add LC Information to the Acquisition Method

1. Click Acquisition Method in the left pane, and then set Synchronization Mode to LC Sync.

NanoLCTM SystemsSystem Integration Test and Data Log
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Figure 2-4 Acquisition Method Properties Tab—Synchronization Mode

2. Click the autosampler (for example, Eksigent AS2 or AS3) and then select the appropriate autosampler method.
Refer to Create the Autosampler Method.

3. If Eksigent Gradient 2 appears in the device list, right-click Eksigent Gradient 2 and then clear the "Use"
selection as it is not being used.

4. Click Eksigent Gradient 1 and then select the appropriate gradient pump method. Refer to Create the
Gradient Method.

Figure 2-5 Software Application Properties Tab—Gradient 1 Method

5. Click Eksigent Loading Pump and then select the appropriate loading pump method. Refer to Create the
Loading Pump Method.

6. Save the acquisition method.

System Integration Test and Data LogNanoLCTM Systems
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Prepare the System for Testing
Plumb the system in trap-elute configuration to perform the pre-column desalting workflow. Refer to Plumbing
Diagrams. For wiring information for a NanoLCTM or TempoTM System with the cHiPLC

®
. Refer to Wire Connections.

Prepare the 1 pmol/µL Stock Solution of Beta-Galactosidase
Digest Solution

WARNING!  Toxic Chemical Hazard. Refer to the chemical product Safety Data Sheets
and follow all of the recommended safety procedures when handling, storing, and
disposing of chemicals. For health and safety precautions, refer to the Operator
Guide.

Required Materials

• Beta-galactosidase digest (PN 4465938)

• Buffer A

1. Add 625.0 µL of buffer A (100% water:0.1% formic acid) to the beta-galactosidase vial.

2. Vortex the vial for at least 30 seconds.

3. Using a centrifuge, spin the vial to bring the liquid down to the bottom of the vial before opening.

4. Repeat step  2 to step  3 to confirm dissolution.

5. Aliquot the stock solution into 50 µL volumes and then store them at –35 °C to –15 °C for up to one year.

Note: Aliquots of the beta-galactosidase stock solution can be stored at 4 °C for up to three days after
thawing.

Condition the System
A trap and column typically require two to three runs with 200 fmol/µL of protein digest for conditioning. Prepare
a 200 fmol/μL dilution and use it in two or three 1 μL injections at the beginning of the batch.

If the column is already conditioned, this procedure is not required. Proceed to Prepare the Sample for the System
Integration Test.

NanoLCTM SystemsSystem Integration Test and Data Log
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Prepare a 200 fmol/µL Dilution of the Beta-Galactosidase to Condition the System

Required Materials

• Stock solution, prepared in Prepare the 1 pmol/µL Stock Solution of Beta-Galactosidase Digest Solution

1. Combine 40 µL of buffer A (100% water:0.1% formic acid) with 10 µL of the stock solution in a clean vial.

2. Mix the solution for at least 30 seconds using a vortex mixer.

This step produces a 1:5 dilution, with a concentration of 200 fmol/µL.

3. Transfer the solution to the autosampler vial, making sure there is no bubble on the bottom of the vial.

Prepare the Sample for the System Integration Test

Required Materials

• Beta-galactosidase stock solution, prepared in Prepare the 1 pmol/µL Stock Solution of Beta-Galactosidase
Digest Solution

• Water with 0.1% formic acid (Buffer A)

1. Combine the specified amount of the 1 pmol/µL beta-galactosidase stock solution with Buffer A in clean vial.
Refer to Table 2-3.

Table 2-3 Sample Dilutions by Mass Spectrometer

Final
Concentration

Stock Solution
(µL)

Buffer A (µL)System

25 fmol/µL10390TripleTOF
®
 4600 System

TripleTOF
®
 5600/5600+ System

TripleTOF
®
 6600/6600+ System

2. Mix the solution for at least 30 seconds using a vortex mixer.

3. Transfer the solution to the autosampler vial, making sure that there is no bubble on the bottom of the vial.

Verify System Readiness
Make sure that the LC system meets performance specifications.
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Note: For information about assembly and operation of the NanoSpray
®
 or OptiFlowTM Turbo V Ion Source, refer

to the  Ion Source Operator Guide. For information about assembly and operation of the Digital PicoView
®

Nanospray Ion Source, refer to the Digital PicoView Nanospray Source Hardware Manual.

Note: Optimize the ion source before beginning this test.

1. Connect the flow from the LC system to the ion source and verify that the spray is stable by monitoring the
background signal in the Analyst

®
 TF Software.

2. Equilibrate the LC-MS system with the starting conditions of the method outlined above.

3. On the Navigation bar, double-click Manual Tuning.

4. Type the key parameters from Table 2-4 and then click Start to begin acquisition. Refer to the following figures
as an example.

Figure 2-6 TOF MS Parameters

NanoLCTM SystemsSystem Integration Test and Data Log
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Figure 2-7 TOF Advanced MS Parameters

Table 2-4 Key Parameters

ValueParameter

MS

TOF MSScan type

1.0Accumulation time (sec)

PositivePolarity

400 to 1800TOF masses (Da)

0.5Duration (min)

Advanced MS

OnMCA

OnAuto Adjust with mass

Default (with Auto-adjust)Q1 Transmission window

Default (with Auto-adjust)Pulsar frequency

4Time bins to sum

System Integration Test and Data LogNanoLCTM Systems
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Table 2-4 Key Parameters (continued)

ValueParameter

DefaultSettling time

DefaultPause between mass ranges

Source/Gas

5 (or as optimized)Ion Source Gas 1 (GS1)

20 (or as optimized)Curtain Gas (CUR)

150 (or as optimized)Temperature (TEM) (ºC)

2300 (or as optimized)IonSpray Voltage Floating (ISVF) (V)

Compound

70 (or as optimized)Declustering Potential (DP)

Figure 2-8 TOF MS Scan for Background Noise

5. Make sure that the spray is still stable by monitoring the background signal with a TOF MS scan.

An example of stable spray is shown on the left side of the previous figure (the spectrum on the right will vary
system to system).  Refer to Figure 2-8.

Unstable spray can be caused by air bubbles in the spray and appears as shown in the following figure. Bubbles
in the spray are almost always caused by a poor post-column fitting.

• If air bubbles are present in the spray, verify that all post-column fittings and connections have been made
properly.

• If the spray is not stable, tune the ion source again by infusion. Refer to the Operator Guide.

NanoLCTM SystemsSystem Integration Test and Data Log
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Figure 2-9 Unstable Spray Induced by Air Bubbles

Perform the System Integration Test
Create the acquisition batch, run the batch and then verify the results. Type the test results in the System Integration
Test Data Log and Signoff.

Note: If the system includes a cHiPLC
®
 System, make sure that the cHiPLC

®
 System is in the Load position before

beginning this test.

Create the LC-MS Acquisition Batch

1. Double-click Build Acquisition Batch on the Navigation bar.

2. On the Sample tab, in the Acquisition group, select the acquisition method created in Create the Acquisition
Method from the list.

System Integration Test and Data LogNanoLCTM Systems
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Figure 2-10 Sample Tab—Acquisition Group

3. Click Add Set.

4. Click Add Samples.

Figure 2-11 Add Sample Dialog

5. Specify the sample information as shown in the previous figure. Refer to Figure 2-11.

a. In the Number field, type 10.

b. Click OK.

6. Specify the rack and plate position for the samples as shown in the following figure. Refer to Figure 2-12.

NanoLCTM SystemsSystem Integration Test and Data Log
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Figure 2-12 Sample Tab—Method Creation

7. Create a batch. Refer to Figure 2-12.

8. Save the batch file as YYYYMMDD LC TOFMS BGal Integration Test.

9. On the Location tab, identify the position of the beta-galactosidase sample vial.

System Integration Test and Data LogNanoLCTM Systems
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Figure 2-13 Locations Tab

Run the Batch

1. Click Submit on the Submit tab.

NanoLCTM SystemsSystem Integration Test and Data Log
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Figure 2-14 Submit Tab

2. Click View > Sample Queue.

3. Click Acquire > Start Sample.

Assess the Results

Assess the TOF MS Data in the PeakView
®
 Software

1. Open the data file and double-click the arrow in the middle of the X-axis (Time, min) to display the individual
TICs.

2. Right-click TIC from Experiment 1, +TOF MS in the top left corner of the graph.

3. Select Remove all Traces Except Active to display only the TOF MS TIC plot.

4. Extract the TOF MS peak XICs for the target peptides:

a. Click Show > Extract Ions Using.

System Integration Test and Data LogNanoLCTM Systems
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b. Specify the masses and extraction width for the peptides as shown in Figure 2-15. Only the masses and
widths are required.

Note: These peaks are the most stable and the most reproducible from batch-to-batch and from lot-to-lot.

Figure 2-15 Specify XIC Ranges Dialog

5. Click OK.

The XICs for each peptide are generated. The peak areas of the extracted peaks can be used to evaluate the
MS sensitivity and the peak retention times can be used to evaluate the chromatography.

Note: The XIC can be used to evaluate the NanoLC peak retention times and shapes. Peak widths, retention
times, and XIC width vary from LC system to LC system depending on transfer line volumes, column type
used, column age, and more.

6. In the XIC pane, click and drag across the range of the more intense peaks, as shown in Figure 2-16.

NanoLCTM SystemsSystem Integration Test and Data Log
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Figure 2-16 TOF MS XICs of Peptides from Beta-galactosidase NanoLC Ultra
®
 Trap Elute

Run (25 fmol on column)

7. Click Window > Graph Selection Window.

8. Record the peak area and resolution for each XIC.

Note:  Only the peak area for the selected peptide XIC (in bold text in the heading in the top left corner)
will be displayed in the Graph Selection window. Individually select each peptide XIC in the top left
heading to display the corresponding peak area.

Note: This test is not a specification. Use this example to confirm injection and peak separation and shape
only. Refer to the peak area specification in the Installation Checklist and Data Log. Refer to the “TOF
MS Test” section in the Ion Source Tests, Specifications and Data Log document for resolution
specifications for the NanoSpray

®
 Ion Source.

9. Make sure that the peaks have good separation and shape using the PeakView
®
 Software:

a. Click Window > Graph Selection Window.
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b. Record the retention times of the chosen peaks.

Retention times will vary with each system. Time of elution of the first is about 14 minutes to 16 minutes.
The longer elution time indicates that LC dead volume should be minimized.

Note: Most of the XICs obtained should have peak widths of approximately 0.2 minutes half height on
average and have peak intensities similar to those shown in Figure 2-16. Some peaks will be narrower
and some will be broader.

Record the Results in the Data Log

1. Calculate the average peak area and average peak resolution for the last three injections for the following four
peptides:

• 729.4 m/z

• 714.8 m/z

• 671.3 m/z

• 542.3 m/z

2. Record the values in the Data Log. Refer to Table 3-8 and Table 3-9.

3. Examine the last three injections to make sure that the average peak area for each of the four QC peaks meet
the minimum requirements specified in the Data Log.

4. Record the retention time for the last three samples analyzed for the following three peptides:

• 729.4 m/z

• 671.3 m/z

• 542.3 m/z

The absolute retention time will vary with each system.

Tip! Use a column oven to increase the retention time reproducibility. The temperature effect on retention
time differs from peptide to peptide. In order to get the retention time reproducibility within specification,
the temperature of the column should be stable within 1 °C. Factors to consider include not only the column
temperature itself, but the room temperature, especially during overnight runs as the room temperature can
shift dramatically.

5. Calculate the difference between the latest and earliest elution of each peptide and record the difference in
the Data Log. Refer to Table 3-10.

6. Make sure that the difference meets the minimum requirements specified in the Data Log.
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Troubleshoot Peak Issues
This section provides information for troubleshooting peak related problems such as broad or tailing peak widths,
lack of separation between peaks, and low peak area.

Peak widths are too broad or are tailing
• Inspect all connections in the flow path to verify that there are no dead volumes.

• Look at connections post-column and around the trap column. A small increase in peak width is often seen
when a trap column is used.

• Broad peaks may also result from overloading the column. If this occurs when conditioning the column, ignore
it. If this occurs during a sample run, either decrease the injection volume or dilute the sample and then inject
the sample again.

CAUTION: Potential System Damage: If peak with problems persist and a cHiPLC
®
 System

is in use, do not attempt to troubleshoot the fittings connected to the chip.

No separation between the peaks
• Make sure that both pumps are delivering the correct amount of solvent.

• Make sure that the pressure drop upon injection is not too severe in the high-flow channel (change in pressure
less than 300 psi).

• A large pressure drop upon injection suggests an air bubble has been introduced to the sample loop or is
present in the trap column plumbing.

Note: The overall separation with trap and elute will often be less than with direct injection. Components that
elute comparably on the trap and analytical column will not resolve on the analytical column and, as a result,
spread out or bunch together.

Peak intensity or peak area is too low
• Verify that the correct amount of sample has been withdrawn from the autosampler vial by performing an

aspiration test.

• Verify the performance of the mass spectrometer and the ion source spray.

• For the NanoSpray
®
 or OptiFlowTM Turbo V Ion Sources, refer to the infusion tests in the Ion Source Tests,

Specifications, and Data Log document.

• For the Digital PicoView
®
 Nanospray Ion Source, refer to the NanoLC Systems Installation Checklist

and Data Log.
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• If there is a large pressure drop upon injection, inspect for air bubbles in the sample loop or trap column
plumbing.

• Verify that the trap and analytical column are well conditioned with protein digest injections before performing
this test. A trap typically requires two to three runs with 200 fmol of protein digest on the column for
conditioning.

• Perform a direct injection with a protein digest on the analytical column to determine whether the problem is
related to the trap, or 10-port switching valve, or the cHiPLC

®
 System.

• If the first LC peak does not elute for a long time, inspect the system for dead volume.

Tip! Minimize tubing length wherever possible and make sure that all the tubing for the flow path for the
gradient channel has an inner diameter of 18 µm to 25 µm.

• If the early eluting peaks are not visible or are very low in intensity, replace the trap. Invisible or low-intensity
peaks can result from trapping efficiency.
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• If the late eluting peaks are not visible or are very low in intensity, the column might be getting old. In rare
cases, the beta-galactosidase standard is degraded. The following figure is an example of a scan with an older
column. Refer to Figure 2-17.

Figure 2-17 Extraction of All Peaks, Late Eluting Peaks Not Present

• Always monitor the column and trap pressure over time. Increasing pressure often indicates increasing blockage,
probably at the ion source emitter tip. If the pressure drops quickly when the connection between the column
and the ion source is unfastened, the tip is getting clogged and should be changed.

• For better long-term column lifetime, verify that the pressure drops at least 30% during the high organic flush
of the column. Increase the duration of the high organic flush until a good pressure change is observed. This
time might increase for the trap column configuration relative to the direct injection configuration.
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• The following figure shows a minimal pressure change upon injection (at time 0) and a 30% pressure decrease
(at 23 minutes to 30 minutes) during the high organic flush. Refer to Figure 2-18.

Figure 2-18 Good Pressure Profile for a Trap-and-Elute Run
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Beta-galactosidase lot number:

System Information
Table 3-1 Pump Information

Model

Location

Serial number

Table 3-2 Autosampler Information

Model

Serial number

Table 3-3 (Optional) cHiPLC® System Information

Model

Serial number

Table 3-4 (Optional) A/D Converter

Model

Serial number
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Table 3-5 (Optional) Column Oven

Model

Serial number

Table 3-6 Ion Source Information

Model

Serial number

Table 3-7 Mass Spectrometer Information

Model

Serial number

Peak Area and Resolution
Most of the XICs obtained should have peak widths of approximately 0.2 min half height on average. Some peaks
will be narrower and some will be broader.

Additionally, verify that the peaks elute within five minutes of each other.

Table 3-8 TOF MS Data: Peak Area

Avg. Peak AreaPeak Area SpecPeptide IDTOF-MS

1.0 × 105GDFQFNISR542.2645

2.0 × 105VDEDQPFPAVPK671.3379

5.0 × 104DWENPGVTQLNR714.8469

2.0 × 105APLDNDIGVSEATR729.3652

Specification Passed?
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Table 3-9 TOF MS Data: Average Peak Resolution

Average ResolutionPeptide IDTOF-MS

GDFQFNISR542.2645

VDEDQPFPAVPK671.3379

DWENPGVTQLNR714.8469

APLDNDIGVSEATR729.3652

Resolution should be ≥ 25 000 for all peaks.

Specification Passed?

Retention Time
For the three peptides, record the retention time for the last three samples analyzed then calculate the difference
between the latest and earliest retention times.

Tip! Use a column oven to increase the retention time reproducibility. The temperature effect on retention time
differs from peptide to peptide. In order to get the retention time reproducibility within specification, the
temperature of the column should be stable within 1 °C. Factors to consider include not only the column
temperature itself, but the room temperature, especially during overnight runs as the room temperature can
shift dramatically.

Table 3-10 Retention Time for Beta-Galactosidase Peptides

DifferenceRetention TimePeptide m/z

Run CRun BRun A

729.4

671.3

542.3

For NanoLCTM 400 Systems, difference should be < 0.3 min.

For NanoLC Ultra
®
, NanoLCTM and TempoTM Systems, difference should be < 0.5 min.

Specification Passed?
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Comments and Exceptions

Signoff

Organization

Date
(yyyy-mm-dd)

Customer contact
name

Customer contact
signature

Date
(yyyy-mm-dd)

FSE name

FSE signature
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This appendix includes method parameters for a NanoLCTM 400 System with a cHiPLC
®
 System.

For methods for a NanoLCTM 400 System with an external trap and column, refer to Methods for NanoLCTM 400
Systems with an External Trap and Column.
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Autosampler Method Parameters

Figure A-1 Method Editor Dialog

The following table contains the autosampler method parameters as they are shown in the Advanced Editor
dialog. Refer to Table A-1.
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Table A-1 Advanced Editor Autosampler Method Parameters

DescriptionCommand

Autosampler DeviceInitialize

for 0:00:01Wait

Pre-wash—1 ×Needle Wash

for Gradient 1 ready to startWait

for Loading pump ready to startWait

µL Pickup—1 µL—0.5 µL/s—2 mm from bottomGet Sample

Loading PumpStart

Injector InjectValve

Wait for loading pump injection completeWait

Gradient Pump 1Start

Injector LoadValve

Clean Up—5 ×Needle Wash
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Loading Pump Method Parameters

Figure A-2 LC Method Settings Dialog—Run Conditions

Table A-2 Loading Pump Method Parameters (Gradient Table Tab)

QaTimeStep

201

2102
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Gradient Pump Method Parameters

Figure A-3 LC Method Settings Dialog—Run Conditions Tab (cHiPLC
®
 System)

Table A-3 Gradient Method Parameters (Gradient Table Tab)

Event% B% ATimeStep

59501

59512

2575163

8020184
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Table A-3 Gradient Method Parameters (Gradient Table Tab) (continued)

Event% B% ATimeStep

8020245

595276

595457

Note: Flow rate is set to 300 nL/min.
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This appendix includes method parameters for a NanoLCTM 400 System with an external trap and column.

For methods for a NanoLCTM 400 System with a cHiPLC
®
 System, refer to Methods for NanoLCTM 400 Systems with

a cHiPLC
®
 System.
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Autosampler Method Parameters

Figure B-1 Method Editor Dialog

The following table contains the autosampler method parameters as they are shown in the Advanced Editor
dialog. Refer to Table B-1.
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Table B-1 Advanced Editor Autosampler Method Parameters

DescriptionCommand

Autosampler DeviceInitialize

ISS-A LoadValve

Pre-wash—1 × using Wash Solvent 1Needle Wash

for Gradient 1 ready to startWait

for Loading Pump ready to startWait

µL Pickup—1 µL - 0.5 µL/s - 2 mm from bottomGet Sample

Loading PumpStart

Injector InjectValve

for Loading Pump injection completeWait

ISS-A InjectValve

Gradient Pump 1Start

Injector LoadValve

Clean Up—5 × using Wash Solvent 1Needle Wash
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Loading Pump Method Parameters

Figure B-2 LC Method Settings Dialog—Run Conditions

Table B-2 Loading Pump Method Parameters (Gradient Table Tab)

QaTimeStep

201

2102
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Gradient Pump Method Parameters

Figure B-3 LC Method Settings Dialog—Run Conditions Tab (External Column)

Table B-3 Gradient Method Parameters (Gradient Table Tab)

Event% B% ATimeStep

59501

59512

2575163

8020184
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Table B-3 Gradient Method Parameters (Gradient Table Tab) (continued)

Event% B% ATimeStep

8020245

595276

595457

Note: Flow rate is set to 300 nL/min.
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This appendix includes method parameters for a NanoLC Ultra
®
 System with a cHiPLC

®
 System.

For methods for a NanoLC Ultra
®
 System with an external trap and column, refer to Methods for NanoLC Ultra

®

Systems with an External Trap and Column.

Autosampler Method Parameters
This table contains the autosampler method parameters as they are shown in the Method Editor dialog.

Table C-1 Autosampler Method Parameters

ValuesParameterValueCommand

Injector LoadValve

Wait for Gradient 1 ReadyExternal Events

Wait for Loading Pump ReadyExternal Events

Port 150 µLNeedle Wash

Speed: 1

Height: 5

Reagent-119 µLAspirate

00:00:05Wait

Speed: 1

Height: 5

Reagent-10 µLAspirate

Speed: 1

Height: 3

Sample1 µLAspirate

00:00:05Wait

Speed: 1

Height: 3

Sample0 µLAspirate

Speed: 1

Height: 5

Reagent-15 µLAspirate

00:00:05Wait
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Table C-1 Autosampler Method Parameters (continued)

ValuesParameterValueCommand

Speed: 1

Height: 5

Reagent-10 µLAspirate

Start Loading PumpExternal Events

Injector InjectValve

Wait for Loading Pump InjectExternal Events

Injector LoadValve

Start Gradient 1External Events

Speed: 5

Height: 0

Waste25 µLDispense

Port 1200 µLNeedle Wash

END
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Loading Pump Method Parameters

Figure C-1 LC Method Settings Dialog—Run Conditions

Table C-2 Loading Pump Method Parameters (Gradient Table Tab)

QaTimeStep

201

2102
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Gradient Pump Method Parameters

Note: The events shown below verify the correct switching of the cHiPLC
®
 valve. The signals at Time 0 will

move the cHiPLC
®
 valve to the Inject position and the signal at Time 45 will move the cHiPLC

®
 valve back to the

Load position.

Figure C-2 LC Method Settings Dialog—Run Conditions Tab (cHiPLC
®
 System)
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Table C-3 Gradient Method Parameters

Event% B% ATimeStep

AUX3 TTL Low59501

AUX4 TTL High59502

AUX3 TTL High5950.13

2575164

8020185

8020246

595277

AUX4 TTL Low596458

Note: Flow rate is set to 300 nL/min.
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This appendix includes method parameters for a NanoLC Ultra
®
 System with an external trap and column.

For methods for a NanoLC Ultra
®
 System with a cHiPLC

®
 System, refer to Methods for NanoLC Ultra

®
 Systems with

a cHiPLC
®
 System.

Autosampler Method Parameters
This table contains the autosampler method parameters as they are shown in the Method Editor dialog.

Table D-1 Autosampler Method Parameters

ValuesParameterValueCommand

Injector LoadValve

Wait for Gradient 1 ReadyExternal Events

Wait for Loading Pump ReadyExternal Events

Port 150 µLNeedle Wash

Speed: 1

Height: 5

Reagent-119 µLAspirate

00:00:05Wait

Speed: 1

Height: 5

Reagent-10 µLAspirate

Speed: 1

Height: 3

Sample1 µLAspirate

00:00:05Wait

Speed: 1

Height: 3

Sample0 µLAspirate

Speed: 1

Height: 5

Reagent-15 µLAspirate
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Table D-1 Autosampler Method Parameters (continued)

ValuesParameterValueCommand

00:00:05Wait

Speed: 1

Height: 5

Reagent-10 µLAspirate

Start Loading PumpExternal Events

Injector InjectValve

Wait for Loading Pump InjectExternal Events

Injector LoadValve

Start Gradient 1External Events

Speed: 5

Height: 0

Waste25 µLDispense

Port 1200 µLNeedle Wash

END
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Loading Pump Method Parameters

Figure D-1 LC Method Settings Dialog—Run Conditions

Table D-2 Loading Pump Method Parameters (Gradient Table Tab)

QaTimeStep

201

2102
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Gradient Pump Method Parameters

Figure D-2 LC Method Settings Dialog—Run Conditions Tab (External Column)

Table D-3 Gradient Method Parameters (Gradient Table Tab)

Event% B% ATimeStep

59501

59512

2575163

8020184
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Table D-3 Gradient Method Parameters (Gradient Table Tab) (continued)

Event% B% ATimeStep

8020245

595276

595457

Note: Flow rate is set to 300 nL/min.
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This appendix includes method parameters for a NanoLCTM and TempoTM Systems with a cHiPLC
®
 System.

Refer to Connecting NanoLCTM and TempoTM Systems with a cHiPLC
®
 System for plumbing information.

For methods for NanoLCTM and TempoTM Systems with an external trap and column, refer to Methods for NanoLCTM

and TempoTM Systems with an External Trap and Column.

Autosampler Method Parameters
This table contains the autosampler method parameters as they are shown in the Method Editor dialog.

Table E-1 Autosampler Method Parameters

ValuesParameterValueCommand

1-OFFOutput

2-OFFOutput

Injector LoadValve

Speed: 1

Height: 5

Reagent-119 µLAspirate

00:00:05Wait

Speed: 1

Height: 5

Reagent-10 µLAspirate

Speed: 1

Height: 5

Sample1 µLAspirate

00:00:05Wait

Speed: 1

Height: 5

Sample0 µLAspirate

Speed: 1

Height: 5

Reagent-15 µLAspirate

00:00:05Wait
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Table E-1 Autosampler Method Parameters (continued)

ValuesParameterValueCommand

Speed: 1

Height: 5

Reagent-10 µLAspirate

1-ONOutput

1-LOWWait for input

Injector InjectValve

1-HIGHWait for input

Injector LoadValve

2-ONOutput

Speed:5

Height: 0

Waste25 µLDispense

Port 1200 µLNeedle wash

END
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Loading Pump Method Parameters

Figure E-1 LC Method Settings Dialog—Run Conditions

Table E-2 Loading Pump Method Parameters (Gradient Table Tab)

QaTimeStep

201

2102
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Gradient Pump Method Parameters

Figure E-2 LC Method Settings Dialog—Run Conditions Tab (cHiPLC
®
 System)

Table E-3 Gradient Method Parameters (Gradient Table Tab)

Event% B% ATimeStep

59501

59512

2575163

8020184
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Table E-3 Gradient Method Parameters (Gradient Table Tab) (continued)

Event% B% ATimeStep

8020245

595276

595457

Note: Flow rate is set to 300 nL/min.
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This appendix includes method parameters for a NanoLCTM or TempoTM System with an external trap and column.

For methods for a NanoLCTM or TempoTM System with a cHiPLC
®
 System, refer to Methods for NanoLCTM and

TempoTM Systems with a cHiPLC
®
 System.

Autosampler Method Parameters
This table contains the autosampler method parameters as they are shown in the Method Editor dialog.

Table F-1 Autosampler Method Parameters

ValuesParameterValueCommand

1-OFFOutput

2-OFFOutput

Injector LoadValve

Speed: 1

Height: 5

Reagent-119 µLAspirate

00:00:05Wait

Speed: 1

Height: 5

Reagent-10 µLAspirate

Speed: 1

Height: 5

Sample1 µLAspirate

00:00:05Wait

Speed: 1

Height: 5

Sample0 µLAspirate

Speed: 1

Height: 5

Reagent-15 µLAspirate

00:00:05Wait
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Table F-1 Autosampler Method Parameters (continued)

ValuesParameterValueCommand

Speed: 1

Height: 5

Reagent-10 µLAspirate

1-ONOutput

1-LOWWait for input

Injector InjectValve

1-HIGHWait for input

Injector LoadValve

2-ONOutput

Speed:5

Height: 0

Waste25 µLDispense

Port 1200 µLNeedle wash

END
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Loading Pump Method Parameters

Figure F-1 LC Method Settings Dialog—Run Conditions

Table F-2 Loading Pump Method Parameters (Gradient Table Tab)

QaTimeStep

201

2102
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Gradient Pump Method Parameters

Figure F-2 LC Method Settings Dialog—Run Conditions Tab (External Column)

Table F-3 Gradient Method Parameters (Gradient Table Tab)

Event% B% ATimeStep

59501

59512

2575163

8020184
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Table F-3 Gradient Method Parameters (Gradient Table Tab) (continued)

Event% B% ATimeStep

8020245

595276

595457

Note: Flow rate is set to 300 nL/min.
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This appendix includes wiring information required when performing the system integration test with a NanoLCTM

or TempoTM System and the cHiPLC
®
 System.

Wire Connections
Table G-1 provides the wiring connections for a NanoLCTM System with the cHiPLC

®
 System. The output on the

NanoLC system (4-pin connector) is usually used for switching the external 10-port valve. However, the 10-port
valve is not used when using the cHiPLC

®
 System. Use the same communication ports, as shown in Table G-1.

Table G-1 Pin Assignments

Input on cHiPLC
®
 SystemOutput on NanoLC System (Valve I/O)

Pin 1 (Ground) [1st on Left]GND

Pin 3 (Position B)Vlv 1

Pin 2 (Position A)Vlv 2

Pin 6 (Interlock signal)Pin 10 (Channel I/O)

System Integration Test and Data LogNanoLCTM Systems
RUO-IDV-05-4557-B68 / 84

G

Connecting NanoLCTM and
TempoTM Systems with a cHiPLC

®

System



WARNING! Ionizing Radiation Hazard, Biohazard, or Toxic Chemical Hazard.
Follow all safety guidelines and applicable local regulations when handling,
storing, and disposing of system components. Components might have been
exposed to hazardous materials.

If the mass spectrometer has not been calibrated recently, then calibrate the system using the [Glu1]-Fibrinopeptide
B, included in the LC-MS Peptide Calibration Kit (PN 4465867).

Note: Do not infuse the tuning solution and then the [Glu1]-Fibrinopeptide B solution. Use mobile phase A to
thoroughly flush the lines between running tests to avoid clogging the emitter tip on the ion source.

Prepare the [Glu1]-Fibrinopeptide B Dilution

Required Material

• [Glu1]-Fibrinopeptide B, included in the LC-MS Peptide Calibration Kit (PN 4465867)

• Standard diluent, included in the LC-MS Peptide Calibration Kit

• Powder-free gloves (nitrile or neoprene is recommended)

• Safety glasses

• Lab coat

For the list of masses for [Glu1]-Fibrinopeptide B, refer to Masses for [Glu1]-Fibrinopeptide B.

Note: Always prepare the dilution just before running the test.

Note: The [Glu1]-Fibrinopeptide B might become lodged in the rubber septum of the vial. Gently tap or shake
it down before opening the vial. Then, partially remove the septum to reveal a slot. Add the dilution solvent
through the slot. Then push the septum back into place and mix well to dissolve.

CAUTION: Potential Wrong Result. Do not use expired solutions.
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1. Add 900 µL of Standard diluent (0.1% formic acid, 10% acetonitrile) to the glass amber vial containing 0.1 mg
[Glu1]-Fibrinopeptide B.

2. Cover the vial tightly, shake it, and then vortex it for at least 2 minutes, to make sure that the peptide is fully
dissolved.

Note:  Peptide concentration may vary depending on the total peptide content and peptide purity of the
standard solution. Refer to the Certificate of Analysis provided by the vendor. At 100% purity, 0.1 mg
[Glu1]-Fibrinopeptide B dissolved as described in the preceding steps produces a stock solution with a
concentration of approximately 66.67 pmol/µL.

3. Aliquot the stock solution in 50 µL volumes into clean tubes. Freeze unused aliquots at –20°C for future use.

4. Put 50 µL of the stock solution into a clean tube and then add 450 µL of standard diluent.

5. Vortex the tube for 30 seconds.

This is a 1:10 dilution, providing 500 µL of a 6.7 pmol/µL solution.

6. Put 50 µL of the 6.7 pmol/µL solution into another clean tube.

7. Add 450 µL of standard diluent.

8. Vortex the tube for 30 seconds.

This is a 1:10 dilution, providing 500 µL of the 667 fmol/µL solution.

9. Put 50 µL of the 667 fmol/µL solution into another clean tube.

10. Add 450 µL of standard diluent.

11. Vortex the tube for 30 seconds.

This is a 1:10 dilution, providing 500 µL of the final 66.7 fmol/µL solution, to be used for the infusion test.

Masses for [Glu1]-Fibrinopeptide B

Table H-1 [Glu1]-Fibrinopeptide B (Monoisotopic Molecular Weight, 1569.6696 Da)

(M+nH)n+ Monoisotopic m/zCharge

1570.6768+1

785.8421*+2

524.2305*+3

393.4247+4
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Table H-1 [Glu1]-Fibrinopeptide B (Monoisotopic Molecular Weight, 1569.6696 Da) (continued)

(M+nH)n+ Monoisotopic m/zCharge

—+5

—+6

* Indicates more commonly observed charged states.

Table H-2 contains the exact monoisotopic masses for the theoretical cleavages of [Glu1]-Fibrinopeptide B, as
calculated for positive ion mode.

Table H-2 Theoretical Fragment Ions of [Glu1]-Fibrinopeptide B

y ionsb ions

Fragmentm/zFragmentm/z

EGVNDNEEGFFSAR1570.6768——

GVNDNEEGFFSAR1441.6342E130.0499

VNDNEEGFFSAR1384.6128EG187.0713

NDNEEGFFSAR1285.5444EGV286.1397

DNEEGFFSAR1171.5014EGVN400.1827

NEEGFFSAR1056.4745EGVND515.2096

EEGFFSAR942.4316EGVNDN629.2525

EGFFSAR813.3890EGVNDNE758.2951

GFFSAR684.3464EGVNDNEE887.3377

FFSAR627.3249EGVNDNEEG944.3592

FSAR480.2565EGVNDNEEGF1091.4276

SAR333.1881EGVNDNEEGFF1238.4960

AR246.1561EGVNDNEEGFFS1325.5281

R175.1190EGVNDNEEGFFSA1396.5652

——EGVNDNEEGFFSAR1552.6663

NanoLCTM SystemsSystem Integration Test and Data Log
71 / 84RUO-IDV-05-4557-B

Mass Spectrometer System Calibration



Edit the Calibration Reference Table for
[Glu1]-Fibrinopeptide B

1. In the Navigation bar, click Tune and Calibrate sidebar.

2. Click Tools > Settings > Tuning Options.

3. On the Calibration tab, click Reference.

4. In the Reference Table Editor, select Glu-Fibrinopeptide B in the Name list.

5. Add the masses in Figure H-1 to the Reference Ions for TOF MS Calibration table (on the left side of
the dialog).

Figure H-1 Glu-Fibrinopeptide B Reference Table

6. Click OK.

7. Click OK in the Tuning Options dialog.

Calibrate in TOF MS Mode

1. Set the method parameters as shown in Table H-3.
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Table H-3 Method Parameters

ValueParameter

MS Parameters

TOF MSScan type

1Accumulation time (sec)

PositivePolarity

400 to 1800TOF masses (Da)

0.5Duration (min)

Advanced MS Parameters

OffMCA

OnAuto Adjust with mass

Default (with Auto-adjust)Q1 Transmission window

Default (with Auto-adjust)Pulsar frequency

4Time bins to sum

DefaultSettling time

DefaultPause between mass ranges

Syringe Pump Method Parameters

0.5Flow rate (µL/min)

100 Gastight (1.46 mm)Syringe Size (µL)

Source/Gas Parameters

3 (or as optimized)Ion Source Gas 1 (GS1)

35 (or as optimized)Curtain Gas (CUR)

75 (or as optimized)Interface Heater Temperature (IHT) (°C)

2300 (or as optimized)Ion Spray Voltage Floating (ISVF)

Compound-dependent Parameters

40 (or as optimized)Collision energy (CE) (V)

Compound Parameters

100 (or as optimized)Declustering Potential
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2. Make sure that spray is stable.

3. Click Acquire and acquire at least 30 seconds of scan data.

4. In the TIC window (lower left) highlight 30 seconds of TIC signal to average.

5. Double-click the highlighted area.

6. In the window that appears (at the bottom of the screen), right-click and select Re-Calibrate TOF from the
menu that appears.

7. In the TOF Calibration window, select [Glu1]-Fibrinopeptide B in the Reference Table list.

8. Make sure that proper experimental masses have been identified from the infusion spectrum and match up
with the reference table theoretical masses.

9. Review the Average Error value displayed to the right of the Calculate New Calibrations button.

10. Click Calculate New Calibrations.

11. Verify that the Average Error value has dropped to less than 2 ppm.

12. In the Calibration Values area, click Calibrate Spectrum.

13. In the Save Current Calibration area, select the Set as Instrument Default and Overwrite
Current File check boxes.

14. Click Entire File to save new calibration for the TOF MS mode.

15. Click Close.

Calibrate in Product Ion Mode

1. Set the method parameters as shown in Table H-4.

Table H-4 Method Parameters

ValueParameter

MS Parameters

Product IonScan type

785.8Product of

1Accumulation time (sec)

PositivePolarity

100 to 1800TOF masses (Da)

OffHigh sensitivity
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Table H-4 Method Parameters (continued)

ValueParameter

OnHigh resolution

0.5Duration (min)

Advanced MS Parameters

OffMCA

OnAuto Adjust with mass

Default (with Auto-adjust)Q1 Transmission Window

Default (with Auto-adjust)Pulsar Frequency

4Time bins to sum

DefaultSettling time

DefaultPause between mass ranges

Source/Gas Parameters

3 (or as optimized )Ion Source Gas 1 (GS1)

35 (or as optimized)Curtain Gas (CUR)

75 (or as optimized)Interface Heater Temperature (IHT) (°C)

2300 (or as optimized )Ion Spray Voltage Floating (ISVF)

Compound-dependent Parameters

45 (or as optimized)Collision energy (CE) (V)

Resolution Parameters

UnitQ1 resolution

2. Make sure that spray is stable.

3. Click Acquire and acquire at least 30 seconds of scan data.

4. In the TIC window (lower left) highlight 30 seconds of TIC signal to average.

5. Double-click the highlighted area.

6. In the window that appears (at the bottom of the screen), right-click and select Re-Calibrate TOF from the
menu that appears.

7. In the TOF Calibration window, select [Glu1]-Fibrinopeptide B in the Reference Table list.
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8. Make sure that proper experimental masses have been identified from the infusion spectrum and match up
with the reference table theoretical masses.

9. Review the Average Error value displayed to the right of the Calculate New Calibrations button.

10. Click Calculate New Calibrations.

11. Verify that the Average Error value has dropped to less than 2 ppm.

12. In the Calibration Values area, click Calibrate Spectrum.

13. In the Save Current Calibration area, select the Set as Instrument Default and Overwrite
Current File check boxes.

14. Click Entire File to save the calibration for the Product Ion mode.

15. Click Close.
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This appendix includes two plumbing diagrams for the trap-and-elute configuration, one for external trap-and-elute,
the other for the cHiPLC

®
 System.

Table I-1 Legend for the Plumbing Diagrams

DescriptionItem

Loading pump1

Syringe dispenser2

Sample needle3

Sample loop4

10-port valve5

Waste6

Column7

To mass spectrometer8

Nanoflow pump9

Trap10

cHiPLC
®
 valve11

Filter12

cHiPLC
®
 column chip13

cHiPLC
®
 trap column14

cHiPLC
®
 trap/elute jumper chip15

Union16

Load

Inject

25 µm i.d., 360 µm o.d.
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Table I-1 Legend for the Plumbing Diagrams (continued)

DescriptionItem

30 µm i.d., 180 µm o.d.

50 µm i.d., 360 µm o.d.

Figure I-1 Trap-and-elute Configuration with External Trap and Column
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In Figure I-2, the nanoflow channel (usually gradient 2) is plumbed from pump to the filter attached to port 8 of
the cHiPLC

®
 System. The microflow channel (usually Channel 1) is plumbed from the pump to port 1 of the

autosampler. Port 6 of the autosampler is plumbed to the filter attached to port 6 of the cHiPLC
®
 System.

Figure I-2 Trap-and-elute Experiment with Optional cHiPLC
®
 System
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This section describes best practices and sample preparation techniques for a NanoLC System.

• Keep the system turned on and fluid flowing at all times. If the system is shut off for more than a few days,
then purge and possibly calibrate the system prior to use. Refer to the appropriate operator guide.

• Use LC-MS-grade pre-made solvents such as those from Burdick-Jackson (that is, HPLC-grade water with 0.1%
formic acid and acetonitrile with 0.1% formic acid). These solvents can be ordered from VWR:

• PN BJLC452-2.5 - Water with 0.1% formic acid

• PN BJLC441-2.5 - Acetonitrile with 0.1% formic acid

Note: We do not recommend using Milli-Q water because it is not of suitable quality for use in LC-MS
systems.

• Verify that the gas flow rate and pressure are consistent. Do not disconnect the gas supply.

• Avoid biological growth.

• Change solutions frequently.

• Include 0.1% formic acid in all mobile phase bottles.

• Verify that the mobile phase solutions in the bottles match the mobile phase and composition values in the
Eksigent Control  Software (System > Mobile Phases).

Table J-1 Recommended Mobile Phase Mixtures

ModifierBuffer BBuffer A

0.1% formic acid100% acetonitrile100% waterGradient 1

0.1% formic acid100% acetonitrile100% waterGradient 2

0.1% formic acidN/A100% waterLoading pump

• Remove air from the mobile phase bottles weekly by purging the system a minimum of 10 times per channel.

• Keep the pump seal wash bottle filled with 5% methanol and change the solutions quarterly.

• Empty the waste bottle once a week or more often if needed.

• Check the flow rate daily. Re-initialize the pressure transducers weekly.

• Pre-swage all fittings.
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• When cutting silica, wash the end with methanol and flow solution through the cut end before connecting.

• Do not cut PEEK-lined fused silica tubing.

• Perform an autosampler Initial Wash or System Wash daily.

Sample Preparation Techniques

WARNING!  Toxic Chemical Hazard. Refer to the chemical product Safety Data Sheets
and follow all of the recommended safety procedures when handling, storing, and
disposing of chemicals. For health and safety precautions, refer to the Operator
Guide.

In general, the standard practices and procedures for reversed phase LC-MS/MS experiments using electrospray
mass spectrometry also apply to the use of the NanoLCTM Systems, including the cHiPLC

®
 System.

• Use HPLC- or MS-grade solvents at all times.

• Avoid the use of non-volatile salts and buffers such as CHAPS, phosphate, TRIS, HEPES, and perchlorates. These
additives will foul the electrospray source and mass spectrometer orifice.

• Centrifuge all samples at 10 000 rpm for 5 minutes to remove particulates from the sample solution.

• Dilute all samples to a maximum of 5% organic modifier to prevent sample precipitation in the chromatographic
system and at the electrospray source. This also ensures binding to the stationary phase.

• Make sure that detergents used during sample preparation are reduced to a concentration less than 0.01%
prior to analysis.
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Table K-1 Beta-Galactosidase Mass Assignments

Charge Statem/zMonoisotopic Molecular
Weight (Da)

Peptide Fragment

3433.881298.62ELNYGPHQWR

2450.7899.38FNDDFSR

3503.241506.69YSQQQLMETSHR

3528.931583.78RDWENPGVTQLNR

2542.271082.51GDFQFNISR

2550.281098.55IDPNAWVER

4567.062264.19DVSLLHKPTTQISDFHVATR

2607.861213.70ITDSLAVVLQR

2671.341340.66VDEDQPFPAVPK

2697.871393.72LPSEFDLSAFLR

2714.851427.68DWENPGVTQLNR

2729.371456.72APLDNDIGVSEATR

2871.951741.89LSGQTIEVTSEYLFR

2879.431756.85VNWLGLGPQENYPDR
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Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX UniversityTM

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists located throughout
the world. They can answer questions about the system or any technical issues that might arise. For more
information, visit the SCIEX website at sciex.com or contact us in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supercedes all previous versions of this document.

To view this document electronically, Adobe Acrobat Reader is required. To download the latest version, go to
https://get.adobe.com/reader.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/customer-documents.
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Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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